Related Documents:


Table of Contents

1. Preface ............................................................................................................................................. 5
   1.1. Conventions ................................................................................................................................. 5
       1.1.1. Notes & Warnings .................................................................................................................... 5
       1.1.2. Typographic Conventions ....................................................................................................... 5
       1.1.3. Procedures ................................................................................................................................ 6
   1.2. We Need Feedback ....................................................................................................................... 6

2. Introduction ........................................................................................................................................ 7
   2.1. About This Guide ......................................................................................................................... 7
   2.2. What is Total Recall VR? ............................................................................................................ 7
   2.3. What is Supervisor Client? .......................................................................................................... 9

3. Start Here .......................................................................................................................................... 11
   3.1. System Requirements .................................................................................................................. 11
   3.2. Compatibility ............................................................................................................................... 11
   3.3. Pre-installation ............................................................................................................................ 11
       3.3.1. Java SE Runtime Environment ............................................................................................... 11
   3.4. Application Installation ............................................................................................................... 12
   3.5. Application Upgrade .................................................................................................................... 19
   3.6. Total Recall VR Configuration .................................................................................................. 19
       3.6.1. Remote Manager Interface ................................................................................................... 20
       3.6.2. Analogue Channels ............................................................................................................... 20
   3.7. First Run ...................................................................................................................................... 21

4. User Interface .................................................................................................................................... 24
   4.1. Menu Bar ...................................................................................................................................... 24
       4.1.1. File Menu ............................................................................................................................... 24
       4.1.2. Help Menu ............................................................................................................................. 25
   4.2. Recording Controls ....................................................................................................................... 25
   4.3. Notes Area .................................................................................................................................... 27
   4.4. Status Bar .................................................................................................................................... 27

5. Access Control .................................................................................................................................. 28
   5.1. Roles ............................................................................................................................................. 28
   5.2. Total Recall VR Access .............................................................................................................. 28
   5.3. Secure Mode ............................................................................................................................... 28
   5.4. User Management ....................................................................................................................... 29
   5.5. Password Recovery ...................................................................................................................... 33
   5.6. Change Own Password ............................................................................................................... 35

6. Application Configuration .................................................................................................................. 36
   6.1. Configuration Location ................................................................................................................. 36
   6.2. Display Language ......................................................................................................................... 36
   6.3. Network Interface ....................................................................................................................... 37
6. Total Recall VR Connections .................................................................38

7. How To ........................................................................................................45
   7.1. Recording .................................................................................................45
   7.2. Monitoring ................................................................................................45
   7.3. Annotating ..............................................................................................45

8. Software License ..........................................................................................46

9. Glossary .........................................................................................................50
   9.1.1. Terms ..................................................................................................50
   9.1.2. Abbreviations ....................................................................................50
1. Preface

1.1. Conventions

Our guides use several conventions to highlight certain words and phrases and draw attention to specific pieces of information.

1.1.1. Notes & Warnings

We use the following visual styles to draw attention to information that might otherwise be overlooked:

- **Notes** are tips, shortcuts or alternative approaches to the task at hand. Ignoring a note should have no negative consequences, but you might miss out on a trick that makes your life easier.

- **Important boxes** detail things that are easily missed: configuration changes that only apply to the current session, or services that need restarting before an update will apply. Ignoring the information will not cause data loss, but may cause irritation and frustration.

- **Warnings** should not be ignored. Ignoring warnings will most likely cause data loss.

1.1.2. Typographic Conventions

We use typographic conventions to call attention to specific words and phrases. These conventions, and the circumstances they apply to, are as follows.

<table>
<thead>
<tr>
<th>Example</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Guide</strong> to display ...</td>
<td>Locate the link named &quot;Guide&quot; on the screen, position the cursor over the link and then depress the appropriate mouse button to follow the link.</td>
</tr>
<tr>
<td>Select <strong>Add</strong> to create a new ...</td>
<td>Locate the button or menu item named &quot;Add&quot; on the screen, position the cursor over the button or menu item and then depress the appropriate mouse button to initiate an action.</td>
</tr>
</tbody>
</table>
Enter **Commission** ... | Locate the field named "Commission" on the screen, position the cursor over the field and then depress the appropriate mouse button to select the field. Once the cursor appears in the field, enter a value.

| Choose **Country** ... | Locate the field named "Country" on the screen, position the cursor over the field and then depress the appropriate mouse button to display the available options. Then position the cursor over the desired option and depress the appropriate mouse button to select it.

| Tick **Active User** ... | Locate the check box named "Active User" on the screen, position the cursor over the check box and depress the appropriate mouse button to place a visual tick in the box.

| Un-tick **Active User** ... | Locate the check box named "Active User" on the screen, position the cursor over the check box and depress the appropriate mouse button to remove the visual tick in the box.

| Enter $30.95 ... | Enter "$30.95" using the keys on your keyboard.

### 1.1.3. Procedures

We use numbered sequence of steps to define procedures for performing certain tasks. For example:

**Procedure Title**

1. This is the first step of the procedure.

2. This is the second step of the procedure.
   
   a. This is the first sub-step of step 2.
   
   b. This is the second sub-step of step 2.

3. This is step three.

### 1.2. We Need Feedback

If you find a typographical error in this guide, or if you have thought of a way to make this guide better, we would love to hear from you.


If you have a suggestion for improving the guide, then try to be as specific as possible when describing your suggestion. Otherwise, if you have found an error, please include the section number and some of the surrounding text so we can find it easily.
2. **Introduction**

2.1. **About This Guide**

This guide describes the Total Recall VR Supervisor Client application. Supervisor Client is a powerful Java™ based PC software application, included with unlimited licenses as part of your Total Recall VR system.

The guide is intended for Total Recall VR end users. It describes how to use Supervisor Client to manually control recording (start/stop) and add notes to recordings in progress. In addition, it shows systems and network administrators how to configure Total Recall VR for use with Supervisor Client.

Please keep a copy of this guide handy for quick reference.

2.2. **What is Total Recall VR?**

Total Recall VR is a professional audio logging and call recording system which is self-contained, fully featured and cost-effective. Enterprises and governments worldwide use it to create electronic records of many forms of audio communication including telephone, 2-way radio, broadcast radio, public address, room microphones and much more.

Total Recall VR is the ideal solution for:

- Recording business telephone conversations;
- Recording agent calls in contact centres;
- Logging emergency response communication;
- Logging business operations communication;
- Logging radio broadcasts;
- Logging public announcements;
- Creating audio records of meetings, legal proceedings, public enquiries and similar events; and
- Creating compliance records to meet duty of care and legal requirements.

Total Recall VR captures all audio in digital format and stores it in a proprietary, secure and tamper proof file format in its on-board hard drive storage. The file format preserves
the originality of the audio that it stores and has a number of built-in mechanisms that aid quick and reliable detection of tampering. However, for ease of access, Total Recall VR client applications can generate copies of recordings in a number of popular and everyday formats such as Microsoft’s Wave (.wav) and MPEG Layer-3 (.mp3).

Storing audio by itself does not help when looking for one recording in a store that can hold hundreds of thousands of recordings. That is why, in addition to audio, Total Recall VR captures and then stores information related to each recording and audio source in its database such as start time, end time and duration of recordings, calling and called numbers on telephone calls, DTMF digits during calls, user configurable notes and much more. This information is the backbone of a powerful search capability which can pin point a single recording in a set of hundreds of thousands of recordings which reside either on the on-board hard drives of a Total Recall VR or in one of many types of off-system archives of recordings.

In addition to the audio recorder and the on-board storage, each Total Recall VR system comes with a built-in media player with comprehensive player controls (start, stop, fast-forward, rewind …). The player can play audio stored in files directly on the system or stream audio to a remote client application which then outputs the sound to the PC speakers of the PC that it runs on.

While audio recording, storage and re-play are the main functions of Total Recall VR, every Total Recall VR offers many more advanced, professional-grade features. For example:

- Ability to capture audio from different types of audio sources (analogue, VoIP, RoIP, AoIP and ISDN), at the same time – hybrid recording.
- Live and real-time monitoring (listening) of recordings in progress on the system itself or on a remote PC with the aid of a PC client application.
- Feature-rich archiver which can create searchable archives of recordings on CD, DVD or BD discs, USB keys or drives and network drives, either automatically or on-demand.
- Automated self-cleaning mechanism that removes obsolete recordings automatically and on regular intervals to keep the system operating endlessly.
- Automated transcoder which compresses audio to free space on the on-board hard drives.
- SNMP agent capable of generating SNMP alarms (traps).
- SMDR integration for a number of popular PBXes.
- Fully internationalised user interface; all menus and software available in multiple languages.
- Role based access control.
- On-board LCD display and control keypad on selected models.
- A number of PC client applications with unrestricted use license.
When audio records are critical to your operations, Total Recall VR delivers. It is professional, reliable and fully self-contained solution for audio logging and call recording that comes at an affordable price.

The Total Recall VR Overview [1] guide contains a comprehensive description and overview of Total Recall VR.

2.3. What is Supervisor Client?

Supervisor Client is a Java™ based PC software application, included with unlimited licenses as part of your Total Recall VR system.

![Supervisor Client Screenshot]

Compatible with Windows 7/8/10, Supervisor Client allows you to manually control (start and stop) recording of analogue audio sources (such as room microphones).

Supervisor Client can connect to a single, or to a pair of, Total Recall VR systems. In the pair scenario, Supervisor Client controls the same channels on both systems at the same time (redundant pair operation).

Supervisor Client offers:

- Single click recording control (start and stop) for multiple analogue recording channels on one, or a pair of, Total Recall VR systems.
- Single click live (real-time) monitoring of audio being recorded on any of the channels under its control. Audio will be streamed in real time from the Total Recall VR to the PC running Supervisor Client as it is being recorded.
- Interface for adding notes to recordings in progress. Notes are stored in the metadata associated with recordings. As a result, users can use key-words that appear in the notes to locate recordings when using Remote Manager.
Go to http://www.totalrecallvr.com/downloads to download the installation files for Supervisor Client, or use the CD supplied with your system.
3. **Start Here**

3.1. **System Requirements**
Supervisor Client is a Java based application designed to run on a PC with Windows 7, 8 or 10.

Supervisor Client should be installed on a PC with (minimum specification shown):

- 100Gb free hard disk space.
- 2Gb memory (RAM).
- Display hardware that supports the 1024x768 resolution.
- Sound system. External speakers or headphones are required to listen to audio when monitoring recordings.
- 10Mbps Ethernet network interface (NIC) hardware.

3.2. **Compatibility**
Supervisor Client will connect to one, or two, Total Recall VR systems. In any case, the software version of Supervisor Client must match the software version of the application that runs on Total Recall VR systems.

If there is a mismatch between the software versions of Supervisor Client and Total Recall VR systems, then Supervisor Client will either fail to connect to Total Recall VR systems or if it connects, it will exhibit problems with some functions.

3.3. **Pre-installation**
Supervisor Client requires 3rd party software and drivers which you must install before installing Supervisor Client.

3.3.1. **Java SE Runtime Environment**
Supervisor Client is a Java application and as such it requires a Java SE runtime environment to run.

You must install a 32bit, version 7 or better Java SE Runtime Environment on your PC to use Supervisor Client.

You can download a Java SE Runtime Environment installer from
You may already have a Java SE runtime environment on your PC. Ask your friendly technical staff to help you determine this if you are not sure how to check.

If your PC is running a 64bit version of Windows, then you may already a 64bit Java SE runtime environment on your PC. If this is the case you must install the 32bit Java SE runtime environment on your PC as well in order to use Total Recall VR Browser. Ask your friendly technical staff to help you if you are not sure what to do.

3.4. Application Installation

A Supervisor Client installer is supplied on the USB key that is included in the box with your Total Recall VR system. The installer is a single self-extracting executable named TRVRSupervisorClient-Setup-x.y.z.yyyyMMdd.exe, where x.y.z.yyyyMMdd is the software version of the application.

The file is located in the SupervisorClient folder on the supplied USB key as shown on the subsequent screen capture.

![Figure 1: Supervisor Client Installer Location on the Software CD](http://www.oracle.com/technetwork/java/javase/downloads/index.html)
If you have misplaced the USB key that came with your Total Recall VR, then go to http://www.totalrecallvr.com/downloads to download the installer for Supervisor Client.

The installer is a wizard based installation program which will guide you through the installation steps. To install Supervisor Client on your PC:

**Install Supervisor Client**

1. Double-click on the TRVRSupervisorClient-Setup-x.y.z.yyyyMMdd.exe file to launch the installer.

2. The installer will start and display the Select Setup Language dialog:

3. Choose the language that you wish to use during the installation. Then select **OK** to display the initial dialog of the installation wizard.

4. Select **Next>** to display the License Agreement dialog:
5. Read and understand the license agreement. Then tick I accept the agreement to continue the installation.

You must accept the agreement as written in order to install Supervisor Client on your PC.

6. Select Next> to display the Destination Location dialog:

This dialog allows you to select the root folder where the installer will place the Supervisor Client application files. By default, the installer places application files in:

- Windows 7 64 bit system: ‘C:\Program Files (x86)\TRVR Supervisor Client’.
- All other systems: ‘C:\Program Files\TRVR Supervisor Client’.

If you wish to change the root folder where the installer will place the Supervisor Client application files, then select Browse to display the Browse for Folder dialog:
7. Select Next> to display the User Files Location dialog:

This dialog allows you to select the root directory where Supervisor Client will store its configuration. By default, the installer will configure Supervisor Client to use:

- Windows 7 64 bit system: ‘C:\Program Files (x86)\Common Files\TRVR Supervisor Client’.

- All other systems: ‘C:\Program Files\Common Files\TRVR Supervisor Client’

If you wish to allow multiple Windows users to use Supervisor Client, then leave the default or select a directory with read and write access for all Windows users that will use Supervisor Client.

If you wish to change the root directory where Supervisor Client will store its configuration, then select Browse to display the Browse for Folder dialog:
Then select a folder and select **OK**.

8. Select **Next>** to display the Start Menu Folder dialog:

![Start Menu Folder Dialog](image)

This dialog allows you to select the name of the Start Menu folder which will contain the shortcuts for the Supervisor Client application.

By default, the installer will create a folder named ‘TRVR Supervisor Client’ and place all application shortcuts in it.

To change the folder, either enter a name for it, or select **Browse** to display the Browse for Folder dialog:
Then select a folder and select **OK**.

9. Select **Next >** to display the Additional Tasks dialog:

10. Optionally tick *Create a desktop icon* if you wish to have an icon on the desktop that will launch Supervisor Client.

11. Select **Next >** to display the Ready to Install dialog:
This dialog shows a summary of all settings that will guide the installer during the installation of Supervisor Client.

If you are unhappy with any of the settings, then select <Back until you reach the dialog that allows you to change them.

12. Select **Install** to install the application. This installer will start the installation and show progress as follows:

13. When done, the installer will show the final dialog:
14. Optionally, tick **Launch SupervisorClient.exe** if you want to run Supervisor Client immediately after you select **Finish**.

15. Select **Finish** to complete the installation.

If you ticked **Launch SupervisorClient.exe** during step 14, then Supervisor Client will start immediately after the installer closes the last dialog.

### 3.5 Application Upgrade

To upgrade Supervisor Client, first uninstall the old version and then install the new version using the installation procedure.

When you uninstall Supervisor Client, the uninstaller does not remove the directory where Supervisor Client stores its configuration files. By default, this directory is:

- **Windows 7 64 bit system**: ‘C:\Program Files (x86)\Common Files\TRVR Supervisor Client’.
- **All other systems**: ‘C:\Program Files\Common Files\TRVR Supervisor Client’.

However, this can be any other directory as explained in step 7 of the installation procedure.

If you specify the same directory during the installation of the new version of Supervisor Client, then the new version will automatically inherit the settings of the previous version.

Otherwise, if you specify a different directory, then you will need to configure Supervisor Client again when you run the new version of Supervisor Client for the first time.

### 3.6 Total Recall VR Configuration

To use Supervisor Client with a Total Recall VR, you must first configure Total Recall VR. The configuration includes:

- Remote Manager Interface (use the Embedded GUI [4] or Remote Manager [5]).
• Analogue Channels (use the Embedded GUI [4] or Remote Manager [5]).

3.6.1. Remote Manager Interface
Supervisor Client uses the Remote Manager Interface provided by Total Recall VR systems to connect and interact with Total Recall VR systems.


Alternatively, see section 11.2.4 Remote Manager Interface in the Total Recall VR Remote Manager User Guide [5] which explains how to configure the Remote Manager Interface on all Total Recall VR models.

3.6.2. Analogue Channels
It is important to configure analogue channels correctly when using Supervisor Client.

The correct analogue channel configuration is:

1. Set channels for **Manual** triggering.
2. Set unique extensions for analogue channels.


If you are using Supervisor Client with a (redundant) pair of Total Recall VR systems, then both systems must have a compatible analogue channel configuration.

A compatible analogue channel configuration is one where the same analogue channels are set for Manual triggering on both Total Recall VR systems. The following screen captures show an example of compatible analogue channel configuration.
Figure 2: Example of Compatible Analogue Channel Configuration

In the example, TRVR Perth has only 8 analogue channels. All channels are used by Supervisor Client. However, TRVR Sydney is used as a backup system. As a result, the first 8 analogue channels have the same configuration as the corresponding channels on TRVR Perth. The rest of the analogue channels on TRVR Sydney are used for recording analogue telephones.

3.7. First Run
Supervisor Client requires at least one administrator user to run. As a result, when you run Supervisor Client for the first time, it will prompt you to enter a username and password so it can create the first administrator user.
Supervisor Client First Run

1. When you start Supervisor Client for the first time it will display the User Preferences dialog which will ask you for the credentials of the first administrator user.

![User Preferences dialog]

2. Enter **User name**.

3. Choose **Language**. Supervisor Client will use this language as a display language when the user logs in.

4. Select **Change Password** to display the Change Password dialog.

![Change Password dialog]

5. Enter **Password** and **Confirm Password**. Both values must be the same.

6. Select **OK** to return to User Preferences dialog.

7. Select **OK** to create the first administrator user and then start Supervisor Client.

From then on, Supervisor Client will display the Login dialog when you run it:
Keep the credentials (user name and password) of the first user in a safe place. They are stored in encrypted form and cannot be recovered from the configuration.

If you lose the credentials of the first user and you do not know the credentials of another administrator user, then you will have to remove the entire Supervisor Client configuration before you can run Supervisor Client again.
4. **User Interface**

Supervisor Client is a GUI application which comprises of:

1. Menu Bar.
2. Recording Controls.
3. Notes Area.
4. Status Bar.

![Figure 4: Supervisor Client User Interface Components](image)

Recording Controls are organised in tabs, where each tab shows up recording controls for up to 12 channels.

4.1. **Menu Bar**

The Supervisor Client menu bar includes 2 menus: File and Help.

4.1.1. **File Menu**

The File menu includes the following options:
1. **Users**

   This menu option is available to users that are administrator only. It opens the Users dialog which allows administrator to manage users, their access credentials and connections to Total Recall VR systems.

2. **User Preferences**

   It opens the User Preferences dialog which allows users to self-manage their password and language preference. Administrators can manage own connections to Total Recall VR systems as well.

3. **Advanced**

   It opens the Advanced Settings dialog which allows users to specify the IP address and port that Supervisor Client will use to accept audio streams from Total Recall VR systems when monitoring recordings in progress.

4. **Exit**

   It terminates Supervisor Client.

### 4.1.2. **Help Menu**

The Help menu includes the following options:

1. **View Web FAQ**

   It starts the default system web browser and loads the FAQ page of the Total Recall VR web site.

2. **View Website**

   It starts the default system web browser and loads the main page of the Total Recall VR web site.

3. **About**

   It display ‘about’ information about the application including the version number of the application.

### 4.2. **Recording Controls**

Supervisor Client organises Recording Controls, one for each analogue channel, on tabs, up to maximum of 12 controls per tab. Each control has 3 buttons and a channel description field.
The Recording button has two states: not recording and recording. Click on this button to start and stop recording on the specified channel. Recording can be active on multiple channels at the same time.

The Monitoring button has two states: not monitoring, and monitoring. Click on this button to start and stop real-time monitoring of a recording which is in progress. Monitoring can be active on a single channel at any one time.

The Notes button has only one state: active. When in the active state, click on this button to add a note to a recording which is in progress.

Supervisor Client does not show any recording controls if it cannot connect to at least the primary Total Recall VR. For example:

*Figure 5: Supervisor Client Recording Controls*

*Figure 6: Missing Recording Controls*
4.3. Notes Area

The Notes Area allows users to type notes to add to recordings which are in progress.

![Figure 7: Supervisor Client Notes Area](image)

Select **Clear** to clear the text in the notes area.

4.4. Status Bar

The Status Bar shows the status of the connection to the Total Recall VR systems.

![Figure 8: Supervisor Client Status Bar](image)

The first entry on the status bar is the connection to the primary Total Recall VR. The second entry is the status of the connection to the secondary Total Recall VR, if one is used.

Text in **red** indicates that the connection is broken. Text in **green** indicates an active and working connection. Three dots “…” indicate a lack of connection configuration.
5. Access Control

5.1. Roles

Supervisor Client uses a role based access control mechanism which is independent from the access control mechanism that exists on Total Recall VR systems. The roles are:

1. Administrator – users in this role are allowed to access all functions of Supervisor Client.
2. User – users in this role are not allowed to manage other users, or to define connections to Total Recall VR system.

5.2. Total Recall VR Access

In addition to role access control, only administrators can define connections to Total Recall VR systems for each user with the User role.

As a result users with the User role can be restricted to access only certain Total Recall VR systems or none at all.

5.3. Secure Mode

Finally, in addition to all previous access control mechanisms, it is possible to run Supervisor Client in a ‘secure’ mode. In this mode Supervisor Client does not display the Main Menu bar and the standard windows controls.

Set the “mode” parameter in the app.properties file to user to start Supervisor Client in ‘secure” mode. To restore normal operating mode set the same parameter to admin. The app.prperties file resides in the installation folder. The default location of this folder is:

- Windows 7 64 bit system: ‘C:\Program Files (x86)\Common Files\TRVR Supervisor Client’.

Figure 9: Supervisor Client Running in Secure Mode

The advantage of the ‘secure’ mode is that users cannot end (or exit) the application.

The app.properties file resides in the installation folder. The default location of this folder is:

- Windows 7 64 bit system: ‘C:\Program Files (x86)\Common Files\TRVR Supervisor Client’.
5.4. User Management

You must be an administrator user to perform the procedures in this section.

In most cases the administrator user that you create when you run Supervisor Client for the first time (see section 3.7 First Run) will then create one or more users that can use Supervisor Client.

It is a good practice to create a “backup” administrator user.

Create a User with Administrator Role

1. Select Users from the File menu.

2. Select Add to display the Add User dialog.
3. Enter *User name* and tick *Admin User*.

4. Choose *Language*. Supervisor Client will use this language as a display language when the user logs in.

5. Select *Change Password* to display the Change User Password dialog:

6. Enter *Password* and *Confirm Password*. Both values must be the same.

7. Select *OK* to return to the Add User dialog.

8. Select *OK* to return to the Update Users dialog which now will show the new user:
9. Repeat steps 2 to 7 to add other administrators.

10. Select OK to complete the procedure.

The new administrator can now use Supervisor Client on the PC. And if the main administrator ever forgets their password, you can use the “backup” administrator to assign a new password to the main administrator.

It is never a good practice to use administrator users. The same rule applies to Supervisor Client. It is recommended that you create users with the User role and use them when working with Supervisor Client.

**Create a User with User Role**

1. Select Users from the File menu.
2. Select **Add** to display the Add User dialog.

![Add User Dialog]

3. Enter **User name**.

4. Choose **Language**. Supervisor Client will use this language as a display language when the user logs in.

5. Select **Change Password** to display the Change User Password dialog:

![Change User Password Dialog]

6. Enter **Password** and **Confirm Password**. Both values must be the same.

7. Select **OK** to return to the Add User dialog.

8. Select **OK** to return to the Update Users dialog which now will show the new user:
9. Repeat steps 2 to 7 to add other users with the User role.

10. Select OK to complete the procedure.

The new user can now use Supervisor Client on the PC.

5.5. **Password Recovery**

You must be an administrator user to perform the procedures in this section.

If you configure only one administrator user, and that user forgets their password, then you will have to remove the entire Supervisor Client configuration and re-configure it just as if you have installed it for the first time on the PC.

It is not possible to recover passwords for Supervisor Client users. An administrator user must set a new password for a user, if the user forgets their password.

At this stage Supervisor Client allows administrator to set any password for users. There are no restrictions.
Set a New Password for a User

1. Select Users from the File menu.

2. Select a user and then select **Update Preferences** to display the Modify User Preferences dialog:

3. Select **Change Password** to display the Change User Password dialog:

4. Enter **Password** and **Confirm Password**. Both values must be the same.
5. Select **OK** to return to the Modify User Preferences dialog.

6. Select **OK** to return to the Update Users dialog.

7. Select **OK** to complete the procedure.

The user can now access Supervisor Client with the new password.

### 5.6. Change Own Password

Every user can change their own password once they have access to Supervisor Client. To change own password:

**Change Own Password**

1. Select **Users Preferences** from the **File** menu.

2. Select **Change Password** to display the Change User Password dialog:

3. Enter **Password** and **Confirm Password**. Both values must be the same.

4. Select **OK** to return to the Modify User Preferences dialog.

5. Select **OK** to complete the procedure.

You must use the new password to log in next time you run Supervisor Client.
6. **Application Configuration**

For best results with Supervisor Client, we recommended that you configure it as explained in this section before using it.

### 6.1. Configuration Location

Supervisor Client stores its configuration in a folder that you specify during the installation of the application. By default this location is:

- Windows 7 64 bit system: ‘C:\Program Files (x86)\Common Files\TRVR Supervisor Client’.
- All other systems: ‘C:\Program Files\Common Files\TRVR Supervisor Client’.

We recommended that you select a folder on the local drive of the PC that runs Supervisor Client when choosing a location for the configuration. You must give read and write permissions to the folder to all Windows (not Supervisor Client) users that will run Supervisor Client on the PC.

It is not possible to use a common Supervisor Client configuration for multiple PCs.

For example, it is not possible to place Supervisor Client configuration in a shared folder and then run Supervisor Client on multiple different PCs, all accessing the configuration in the shared folder.

Each PC must have its own Supervisor Client configuration.

### 6.2. Display Language

Supervisor Client uses the English language as a display language by default. However, each user can choose a different display language.

Administrators can specify the display language for users when they create the accounts for the users. All users can change this setting at any time.

*Change the Display Language*

1. Select **User Preferences** from the **File** menu:
2. Choose **Language**.

3. Select **OK** to complete the procedure.

Supervisor Client will change its display language immediately. There is no need to restart the application.

### 6.3. Network Interface

Supervisor Client uses network connections to communicate with Total Recall VR systems.

If the PC that runs Supervisor Client has a single network interface with a single IP address, which is true in most cases, then Supervisor Client will automatically use the IP address assigned to the network interface. In addition, by default Supervisor Client will use TCP ports 10001 and 10002.

If your machine has more than one network interface, or it has multiple IP addresses assigned to each interface, then you must configure Supervisor Client with the IP address that it should use. This must be an IP address that Total Recall VR systems can connect to, based on the routing rules of your network.

Also, you can change the default TCP ports that Supervisor Client uses if the default ports are in use by other applications on the PC, or you prefer to use different ports in order to configure firewall rules.

To change the IP address and TCP ports:

**Assign IP Address and TCP Ports**

1. From the File menu select **Advanced** to display the Advanced Settings dialog:
2. Select *Local IP Address*. The list will contain all IP addresses that are assigned to the network interfaces on the PC.

3. Enter *Manager base port*. Note that Supervisor Client will use two ports: the base port and base port + 1.

4. Select **OK** to complete the procedure.

5. Restart Supervisor Client.

Supervisor Client will use the new IP address and ports when it starts.

If the PC gets an IP address every time you start it, then:

1. If it has one network interface which receives only one IP address, then Supervisor Client will automatically use the IP address that is assigned to the network interface.

2. If it has multiple interfaces, then you may have to perform the above procedure every time you start the PC.

### 6.4. Total Recall VR Connections

![Advanced Settings](image)

You must be an administrator user to perform the procedures in this section.

Administrators must define up to two connections to Total Recall VR systems for each Supervisor Client user with a User role individually.

While this appears to be a laborious process in the case of multiple users and multiple PCs running Supervisor Client, the strategy offers the flexibility for fine grained control of access to Total Recall VR systems. Each Supervisor Client user on every PC that is used to run Supervisor Client can have different connections, and different restrictions for each connection, to Total Recall VR systems.

Administrators can define one of three different types of connections to Total Recall VR systems:

1. LAN – this type of connections requires a working TCP/IP network between the PC running Supervisor Client and Total Recall VR systems.
2. Dialup – does not work with Supervisor Client.
3. Cascaded – does not work with Supervisor Client.

We recommend you use only LAN connections as the other two types are now considered obsolete and will be removed from future releases of Supervisor Client.

To configure a connection for a Total Recall VR you must know the following information about the Total Recall VR:

1. The password for the Administrator user on the Total Recall VR.

2. The configuration of the Remote Manager Interface on the Total Recall VR system.

The default password for the Administrator user on Total Recall VR systems is 0000. Of course, it could be set to another value. Contact whoever is managing your Total Recall VR and obtain the correct password from them.

You can determine (and if required, change) the configuration of the Remote Manager Interface on Total Recall VR systems with a built-in display from the Options Menu Screen. For example:

![Figure 10: Total Recall VR Remote Manager Interface Configuration](image)

Alternatively, see section 11.2.4 Remote Manager Interface in the Total Recall VR Remote Manager User Guide [5] which explains how to configure the Remote Manager Interface on all Total Recall VR models.

To configure a connection to a Total Recall VR system for a Supervisor Client user:

**Create a Connection to a Total Recall VR for a User**

1. Select Users from the File menu:

2. Select a user and then select Update Preferences to display the Modify User dialog:
3. Click on the TRVR Connectivity tab to show the list of connections to Total Recall VR systems. Of course, the list will be empty if you are creating the first connection for the user.

4. Select Add to display the Add Total Recall VR dialog:

5. Enter **IP Address**. This must be the IP address from the Remote Manager Interface configuration on the Total Recall VR.

6. Enter **Password**. This must be the password for the Administrator user on the Total Recall VR.

7. Enter **Description**. This can be any text. It is used to identify the connection on the Status Bar.

   Do not leave this field blank.
8. Enter **Base Port**. This must be the base port from the Remote Manager Interface configuration on the Total Recall VR.

9. Select **Set** to attempt a connection to the Total Recall VR. This is a network operation and may take some time to complete.

   If Supervisor Client fails to connect to the Total Recall VR, then it will show an error in the dialog.

   In this case you have to correct the problem: configuration, networking etc. before you make another attempt to add the connection.

10. If Remote Manager successfully connects to the Total Recall VR, then it will display the connection in the list of connections for the user:

![](image)

11. Repeat steps 4 to 10 to add a connection to a 2\(^{nd}\) Total Recall VR for the same user if required.

12. Select **OK** to close the Modify User dialog.

13. Select **OK** to complete the procedure.

   If you change the configuration of the Remote Manager Interface on a Total Recall VR system, then you must change the configuration of connections to that Total Recall VR in Supervisor Client for all Supervisor Client users.

### Update a Connection to a Total Recall VR for a User

1. Select **Users** from the **File** menu
2. Select a user and then select **Update Preferences** to display the Modify User dialog

3. Click on the TRVR Connectivity tab to show the list of connections to Total Recall VR systems.
4. Select a connection and then select **Properties** to show the Modify Total Recall VR dialog:

5. Update the parameters as required and select **Set** to attempt a connection to the Total Recall VR with the new parameters.

6. From here on the behaviour of Supervisor Client is the same as from step 9 in the “Create a Connection to a Total Recall VR for a User” procedure.

Note that network connections may take some time to complete (connect). The time it takes depends on the quality (speed, bandwidth, occupancy at time of connection, etc.) of your network.
7. **How To …**

7.1. **Recording**

The main purpose of Supervisor Client is manual control of recording on analogue channels.

Use the Recording Button - ● - to manually start and stop recording on a given channel.

The Recording Button has two states: ● not recording and ● recording. Recording can be active on multiple channels at the same time.

7.2. **Monitoring**

Use the Monitoring Button - ✅ - to manually start and stop monitoring on a given channel. This button is enabled only during active recording.

Monitoring can be active on a single channel at any one time.

The Monitoring Button has two states: ✅ not monitoring, and ✅ monitoring.

7.3. **Annotating**

Use the Add Note Button - ✍ - to add a note to a recording in progress on a given channel. This button is enabled only during active recording.

To add a note to a recording in progress:

1. Type the note text in the Notes Area. Select **Clear** to clear the Notes Area if necessary before typing the note text.
2. Select ✍ next to the channel which is recording to add the note to the recording that is being created on that channel.
8. **Software License**

END USER LICENSE AGREEMENT

THIS SOFTWARE END USER LICENSE AGREEMENT ("EULA") IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR, IF PURCHASED OR ACQUIRED BY OR FOR AN ENTITY, AN ENTITY) AND PROLANCER. IT PROVIDES A LICENSE TO USE THIS SOFTWARE AND CONTAINS WARRANTY INFORMATION AND LIABILITY DISCLAIMERS. BY DOWNLOADING, INSTALLING OR USING THE SOFTWARE YOU ARE INDICATING YOUR ASSENT TO THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO ALL OF THE FOLLOWING TERMS, DO NOT DOWNLOAD OR INSTALL THE SOFTWARE, DISCONTINUE ITS USE IMMEDIATELY AND DESTROY ALL COPIES IN YOUR POSSESSION.

1. DEFINITIONS
   a) "Prolancer" means Prolancer Pty Ltd, an Australian company with ACN 115 942 357.
   b) "Software" means the executable code, additional tools, libraries, source files, header files, data files, any updates or error corrections provided by Prolancer, any user manuals, guides, printed materials, on-line or electronic documentation.
   c) "License Key" means a serial number issued to you by Prolancer to activate and use the Software.
   d) "Named User" is an individual authorized by You to use the Software through the assignment of a single user ID, regardless of whether or not the individual is using the Software at any given time. A non-human operated device is counted as a User in addition to all individuals authorized to use the Software, if such device can access the Software.
   e) "Maintenance Plan" is a time-limited right to technical support and Software updates and upgrades. Technical support only covers issues or questions resulting directly out of the operation of the Software. Prolancer will not provide you with generic consultation, assistance, or advice under any other circumstances.

2. LICENSE GRANTS
   2.1 This Software is licensed, not sold.
   2.2 Freeware License. Prolancer grants you an unlimited license to use the Freeware Features of the Software. The install packages created using only the Freeware Features can be freely redistributed and used both in commercial and non-commercial purpose.
   2.3 Trial Period License. You may download and use the Software for free for thirty (30) days after installation ("Trial Period"). During the Trial Period, Prolancer grants You a limited, non-exclusive, non-transferable, non-renewable license to copy and use the Software for evaluation purposes only and not for any commercial use. At Prolancer's discretion, Prolancer may provide limited support through email or discussion forums at Prolancer’s web site. The evaluation copy of the Software contains a feature that will automatically disable the Software at the end of Trial Period. Prolancer will have no liability to you if this feature disables the Software.
   2.4 License After Trial Period. During the Trial Period, You have the option of paying a license fee in order to use the Software after the expiration of the Trial Period. Upon your payment of the license fee, Prolancer provides you with a permanent registration number ("License key") and grants you a limited, non-exclusive, non-transferable license to:
      a) use the Software on a Named User basis meaning specific individuals are authorized to access the Software and the total number of named users may not exceed the total number licensed by You.
      b) copy the Software in machine-readable form solely for archival and backup purposes.
      c) freely create and redistribute an unlimited number of install packages to an unlimited number of users.
   2.5 The Named User of the Software may install and use the Software on up to five computers (including operating systems and Virtual Machine Environments) that are connected to each other in a network (there has to be a TCP/IP connection between these computers).
   2.6 Floating License. Under the terms of a Floating License, you may install the Software on an unlimited number of machines. All machines using the Software must have the ability to communicate with a license server. The number of users that may use the Software concurrently at any time must not exceed the number of Floating User Licenses purchased for such use.

3. LICENSE RESTRICTIONS
   3.1 You shall undertake any necessary steps to protect the License Key against unauthorized use.
   3.2 You may not alter, merge, modify, adapt or translate the Software, or decompile, reverse engineer, disassemble, or otherwise reduce the Software to a human-perceivable form.
3.3 You may not sell, rent, lease, sub license, transfer, resell for profit or otherwise distribute the Software or any part thereof.
3.4 You may not modify the Software or create derivative works based upon the Software.
3.5 You may not decompile, disassemble or reverse engineer the Software.
3.6 You may not remove or obscure any copyright and trademark notices relating to the Software.

4. USE OF LICENSING FUNCTIONALITY
4.1 If you have licensed a qualifying edition of the Software, you may use the functionality labelled "Licensing" solely for the purposes of applying the Licensing functionality processes and/or restrictions to your products and distributing such products to your end users for their trial purposes for a predetermined period of time. For the avoidance of doubt, the foregoing limitations apply only to your use of the Licensing functionality and not your use of the Software in general.
4.2 You may not use or apply the Licensing functionality for the benefit of any software products which are not owned by you.

5. OWNERSHIP AND INTELLECTUAL PROPERTY RIGHTS
5.1 This Agreement gives you limited rights to use the Software. Prolancer retains all rights, title and interest in and to the Software and all copies thereof, including copyrights, patents, trade secret rights, trademarks and other intellectual property rights. All rights not specifically granted in this Agreement, including International Copyrights, are reserved by Prolancer. The structure, organization and code of the Software are valuable trade secrets and confidential information of Prolancer.

6. LIMITATION OF LIABILITY
6.1 Prolancer's cumulative liability to You or any other party for any loss or damages resulting from any claims, demands, or actions arising out of or relating to this Agreement shall not exceed the license fee paid to Prolancer for use of the Software.
6.2 Prolancer shall be relieved of any and all obligations for any portions of the software that are revised, changed, modified, or maintained by anyone other than Prolancer.

7. PATENT AND COPYRIGHT INDEMNITY
7.1 Prolancer represents and warrants that the Software shall not infringe or misappropriate any copyrights, patents, trade secret rights, trademarks and other intellectual property rights.
7.2 In the event the Software is found to infringe, Prolancer will have the option, at its expense, to a) modify the Software to cause it to become non-infringing; b) substitute the Software with other Software reasonably suitable to You, or c) if none of the foregoing remedies are commercially feasible, terminate the license for the infringing Software and refund any license fees paid for the Software.
7.3 Prolancer will have no liability for any claim of infringement based on a) code contained within the Software which was not created by Prolancer; b) use of a superseded or altered release of the Software, except for such alteration(s) or modification(s) which have been made by Prolancer or under Prolancer's direction, if such infringement would have been avoided by the use of a current, unaltered release of the Software that Prolancer provides to You, or c) the combination, operation, or use of any Software furnished under this Agreement with programs or data not furnished by Prolancer if such infringement would have been avoided by the use of the Software without such programs or data.

8. LIMITED WARRANTIES
8.1 THE SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. PROLANCER MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION ANY IMPLIED WARRANTY OR MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. WITHOUT LIMITATION, YOU ASSUME SOLE RESPONSIBILITY FOR SELECTING THE SOFTWARE TO ACHIEVE YOUR INTENDED RESULTS AND FOR THE INSTALLATION, USE AND RESULTS OBTAINED FROM THE SOFTWARE. PROLANCER MAKES NO WARRANTY THAT THE SOFTWARE WILL BE ERROR FREE OR FREE FROM INTERRUPTIONS OR OTHER FAILURES. IN PARTICULAR, THE SOFTWARE IS NOT DESIGNED FOR USE IN HAZARDOUS ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE. PROLANCER EXPRESSLY DISCLAIMS ANY WARRANTY OF FITNESS FOR HIGH-RISK ACTIVITIES.
8.2 Prolancer warrants that it holds the proper rights allowing it to license the Software and is not currently aware of any actions that may affect its rights to do so.
8.3 Prolancer cannot guarantee that the Software will work at all times. If you change your operating system, the software may not work anymore. You acknowledge and agree that such changes are fair and reasonable.
8.4 You should make sure that it is legal to use the Software in your country or jurisdiction. Prolancer only provides a license for You to use the software. It is Your responsibility to make sure that You are allowed to use the Software.
8.5 Prolancer reserves the right at any time to cease the support of the Software and to alter prospectively the prices, features, specifications, capabilities, functions, licensing terms, release dates, general availability or other characteristics of the Software.

9. MAINTENANCE PLAN
9.1 At any time prior to the expiration of your Maintenance Plan and 14 days after, you may purchase an extension to the current Maintenance Plan. This additional Maintenance Plan will extend the availability of your current Maintenance Plan for a period of time beginning with the date when your Maintenance Plan expires.
9.2 For a limited time after the expiration of your Maintenance Plan, you may purchase a renewal of your Maintenance Plan. This will provide you with a new Maintenance Plan that will begin at the date the renewal is purchased.
9.3 If you do not purchase any additional Maintenance Plan, you will still have the right to use the existing Software but you will lose the right to technical support and Software updates and upgrades as of the date your current Maintenance Plan expires.
9.4 For customers that purchase or already own multiple licenses, a Maintenance Plan must be purchased for each license.
9.5 Technical support is provided via electronic mail at the address specified on the web site. Prolancer will use its best efforts to provide you with technical support within forty-eight (48) business hours of your request. Please check our website to find our latest contact information.

10. SUPPORT
10.1 Except as provided herein, support for the Software is provided to you free of charge while your current Maintenance Plan is valid. If Prolancer discontinues any version of the Software, Prolancer reserves the right to limit or cease product support and updates for such discontinued version. Prolancer reserves the right to discontinue free support with thirty (30) days written notice posted to the Prolancer or the Software web site.

11. INTERNET-BASED SERVICES
11.1 Consent for Internet-Based Services. Certain Software features connect to Prolancer or service provider computer systems over the Internet. In some cases, you will not receive a separate notice when they connect. You may switch off these features or not use them. BY USING THESE FEATURES, YOU CONSENT TO THE TRANSMISSION OF THIS INFORMATION. Prolancer does not use the information to identify or contact you. For more information, see Prolancer’s Privacy Policy on Prolancer’s web site.
11.2 Computer Information. The Software features use Internet protocols, which send to the appropriate systems computer information, such as your Internet protocol address, the type of operating system, browser and name and version of the software you are using, and the language code of the device where you installed the software. Prolancer uses this information to make the Internet-based services available to you.
11.3 Customer Experience Improvement Program (CEIP). The Software may use CEIP, which automatically sends to Prolancer anonymous information about your hardware and how you use this software. We may use the computer information, and CEIP information, to improve our software and services. We may also share it with others, such as hardware and software vendors. They may use the information to improve how their products run with Prolancer software.

12. HIGH RISK ACTIVITIES
12.1 The Software is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-line control equipment in hazardous environments requiring fail-safe performance, such as in the operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life support machines, or weapons systems, in which the failure of the Software could lead directly to death, personal injury, or severe physical or environmental damage ("High Risk Activities"). Prolancer and its suppliers specifically disclaim any express or implied warranty of fitness for High Risk Activities.

13. THIRD PARTY SITES AND SOFTWARE
13.1 The Software may direct you to third party Web sites. Prolancer does not control, endorse, or guarantee content, including software, data or other information found on such third party sites. You agree that Prolancer is not responsible for any content, associated links, resources, or services associated with a third
party site. You further agree that Prolancer shall not be liable for any loss or damage of any sort associated with your use of third party content. Access to these sites is provided for your convenience only.

13.2 The Software may contain third party software. By accepting this EULA, You are also accepting the additional terms and conditions with respect to such software, if any, forth herein.

14. AUDIT RIGHTS
14.1 Prolancer may audits your use of the Software to verify compliance with this Agreement. The Software is configured to enable periodic HTTP communication with Prolancer. During this communication, license information is transmitted from the Software to Prolancer to ensure license compliance. The information transmitted during these periodic updates includes the operating system, license serial number, and other relevant information to verify compliance. If you are unwilling to provide this communication capability, you may opt out of ongoing communication, but you will no longer receive Software updates and search engine configuration updates. If the usage of the Software is considered to be out of compliance with this Agreement, the Software may, without notice, cease to function.

14.2 During the audit process, Prolancer has the ability to personally identify the individual that registered with Prolancer to acquire the Software license ("Registrant") through the identification number assigned to your account at the time of registration, by using the personal information the Registrant provided to Prolancer during the registration process. Such personal information will only be used by Prolancer in connection with such audit process.

15. SEVERABILITY
15.1 If any provision hereof shall be held illegal, invalid or unenforceable, in whole or in part, such provision shall be modified to the minimum extent necessary to make it legal, valid and enforceable, and the legality, validity and enforceability of all other provisions of this Agreement shall not be affected.

16. GOVERNING LAW
16.1 This Agreement is to be governed by and construed in accordance with the laws and jurisdiction of the defending party. Service of process upon either party shall be valid if served by registered or certified mail, return receipt requested and to the most current address provided by such party. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to this Agreement.

17. TERMINATION
17.1 Your license to use the Software continues until terminated. This license will terminate automatically if you fail to comply with any term hereof. No notice shall be required from Prolancer to effect such termination. You may also terminate this Agreement at any time by notifying Prolancer in writing of termination. On termination, you must destroy all copies of the Software. Your obligation to pay accrued charges and fees shall survive any termination of this Agreement.

18. ASSIGNMENT
18.1 Neither this Agreement nor any rights granted hereunder may be sold, leased, assigned, or otherwise transferred, in whole or in part, by you, whether voluntary or by operation of law. Any such attempted assignment shall be void and of no effect without the prior written consent of Prolancer.

19. ENTIRE AGREEMENT
19.1 This Agreement contains the entire agreement between Prolancer and You related to the software and supersedes all prior agreements and understandings, whether oral or written. It may be amended only by a writing executed by both parties.
9. **Glossary**

Our guides use certain terms and abbreviations.

9.1.1. **Terms**

**Recording Channel**

Total Recall VR uses recording channels to capture audio on analogue, VoIP or ISDN sources. The number of recording channels can be different to the number source channels. For example, a Total Recall VR can have 20 ISDN channels while connected to an ISDN PRI link which has 30 B channels.

**Remote Manager**

A powerful Java™ based client application for Total Recall VR systems. It installs on Windows™ PCs and can be used to securely configure and manage multiple Total Recall VR systems over a TCP/IP network. In addition, it can be used to monitor recordings in progress in real time as well as search for and then play past recordings.

**Supervisor Client**

A small Java™ based client application for Total Recall VR systems, It installs on Windows™ PCs and allows users to manually control (start, stop, …) recording on analogue channels. In addition, it can be used to monitor recordings in progress in real time as well as add notes to recordings in progress.

**Total Recall VR**

The system that is the subject of this manual.

9.1.2. **Abbreviations**

Most definitions courtesy of “Wikipedia, the free encyclopaedia”.

**DTMF: Dual-Tone Multi-Frequency**

Used for telephone signalling over the line in the voice-frequency band to the call switching centre. The version of DTMF used for telephone tone dialling is known by the trademarked term Touch-Tone, and is standardised by ITU-T Recommendation Q.23. Other multi-frequency systems are used for signalling internal to the telephone network.

**IP: Internet Protocol**

A data-oriented protocol used for communicating data across a packet-switched internetwork.
IP is a network layer protocol in the internet protocol suite and is encapsulated in a data link layer protocol (e.g., Ethernet). As a lower layer protocol, IP provides the service of communicable unique global addressing amongst computers.

**LAN: Local Area Network**
A computer network covering a small geographic area, like a home, office, or group of buildings.

**TCP: Transmission Control Protocol**
One of the core protocols of the Internet protocol suite, often simply referred to as TCP/IP. Using TCP, applications on networked hosts can create connections to one another, over which they can exchange streams of data using Stream Sockets.

**TRVR: Total Recall VR**
A professional voice logging and call recording system.

**UDP: User Datagram Protocol**
UDP is one of the core protocols of the Internet protocol suite. Using UDP, programs on networked computers can send short messages sometimes known as datagrams (using Datagram Sockets) to one another. UDP is sometimes called the Universal Datagram Protocol.

[End of Document]